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Preface

This document describes how to install the DSNlink Version 2.3E for Tru64 UNIX
software on an Alpha system that runs Compaq Tru64 UNIX.

Overview
The DSNlink software is a service tool that provides electronic communication
capabilities between customers’ systems and a Compaq Customer Support Center.
Using DSNlink, customers can send electronic service requests and receive help
from Compaq specialists. Customers can also use DSNlink to search Compaq’s
technical support databases for information about products for which they have
service contracts.

The installation procedure creates DSNlink file systems subordinate to the
/usr/lib/dsn/ directory and loads DSNlink software subsets.

You can install DSNlink on a local node or from a Remote Installation Services
(RIS) server area.

Keep this document with your distribution kit. You will need it to install
maintenance updates or to reinstall DSNlink for any other reason.

Intended Audience
The audience for this document is the system administrator who installs DSNlink
software.

Structure of this Document
This document is organized as follows:

• Chapter 1, Preparing to Install DSNlink, describes the operating system,
related software, and hardware requirements for DSNlink installation and
the related procedures you complete before the installation.

• Chapter 2, Installing DSNlink on a Tru64 UNIX System, shows a sample
installation.

• Chapter 3, Postinstallation Tasks, describes the postinstallation procedures
you must complete.

• Appendix A, Dialer Driver Script Facility Commands, is a list of the
commands you can enter in modem dialer scripts.

• Appendix B, DSNlink Directories on Your System, describes the hierarchy
and contents of DSNlink Version 2.3E directories.

For a list of the documentation, see Chapter 3.
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Conventions Used in This Document
This document uses the conventions listed in Table 1, as needed:

Table 1 Manual Conventions

Convention Description

UPPERCASE
and lowercase

DSNlink parameters and other file entries are case insensitive.
However, command and options are case sensitive. To avoid errors,
enter information in examples as shown.

Compaq’s
DIGITAL
UNIX®

Refers to the DIGITAL UNIX operating, which is now owned by
Compaq Computer Corporation.

DSNlink The abbreviated service tool name is used for convenience to refer to
the DSNlink Version 2.3 for Compaq’s DIGITAL UNIX software.

boldface text Boldface text is used in examples to show what the user types to
contrast that with the results of the command.

monospace
type

Monospace type designates commands and examples.

% A percent sign is the default prompt for the C shell.

# A number sign is the default superuser prompt.

[ ] Square brackets indicate you must choose one or more of the
parameters or variables within the brackets.

{ } Curly braces indicate that all parameters or variables within the braces
are optional.

.

.

.

A vertical ellipsis indicates the example continues, but the additional
text is not displayed.

vi



1
Preparing to Install DSNlink

This chapter contains information you need to know or verify before installing
DSNlink.

1.1 Overview of the Installation Process
The DSNlink installation procedure uses setld. It does not require shutting down
your system.

Restrictions
These restrictions apply to the DSNlink installation:

• You cannot have DSNlink Version 2.3E and any previous versions of DSNlink
on the same system. If there is a previous version of DSNlink on the system,
you must delete it before installing DSNlink Version 2.3E. See Section 1.8.

• The change to support X.25 router nodes requires that all customers who use
X.25 and the host run DSNlink Version 2.2E.

Important

If you use X.25, contact your Customer Support Center to coordinate your
DSNlink Version 2.2E installation with their host DSNlink Version 2.2E
installation.

If you do not use the X.25 transport, you can install DSNlink Version 2.3E
without coordinating the installation with the Compaq host.

Note that some countries do not support the X.25 transport.

Recommendations
Compaq recommends that you back up your system before installing any
software. For details on performing a system backup, see your Tru64 UNIX
documentation.

Install DSNlink on a gateway node first. A gateway node is one that has a direct
connection to Compaq. After installing on a gateway, you can install DSNlink on
systems that connect to the gateway.

Note that if your site has multiple DSNlink nodes, you do not have to install
DSNlink Version 2.3E on all nodes. It is compatible with previous versions of
DSNlink.

Preparing to Install DSNlink 1–1
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1.1 Overview of the Installation Process

What the Installation Procedure Does
The DSNlink installation procedure does the following:

1. Presents an Electronic Service Tools agreement. If you agree to the terms, the
installation procedure continues. To preview the agreement, see the sample
installation script in Chapter 2.

2. Checks for the supported versions of Tru64 UNIX, Versions 4.0b, 4.0d, or 5.0.

3. Verifies that you have sufficient disk space for DSNlink.

4. Checks for previously installed versions of DSNlink

5. Prompts you for a unique group for the DSNlink executables and files

For more information, see Section 1.6.3.

6. Sets the group ownership of the files or directories to the group you created

7. Prompts you for your access number or numbers, the node’s name, your
Customer Support Center, which transports you want to use with DSNlink,
the name of a person to contact if Compaq must reach you by telephone, and
your authentication key

8. Adds entries to /etc/services and /etc/inetd.conf for communications with the
DSNlink host system, if you agree to the additions

9. Prompts you for information necessary to configure each of the transports

For more information, see Section 1.7.2.1.

10. Runs the DSNlink Network Exerciser to test the connection to the host
system

1.2 What You Need from Compaq
If your site has no earlier versions of DSNlink, you need an authorization letter
from Compaq before installing DSNlink. The letter contains the following items:

• Your access number. Instead of an access number, your letter may have a
contract number or serial number.

• Your authentication key

• The location of your Customer Support Center.

The installation procedure prompts you for the previous items.

If you have previous versions of DSNlink, you do not need an authorization letter.
You can use the same access number and Customer Support Center.

Note

It is extremely important to keep your authentication key secret. Anyone
who has your access number, authentication key, and DSNlink has access
to your DSNlink account.

What You Do Not Need
There is no license necessary to use DSNlink.
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1.3 Release Notes

1.3 Release Notes
DSNlink provides online release notes only. Compaq recommends you read the
release notes before using the product.

For the location of the release notes and other online documents, see Section 3.1.

1.4 How to Get DSNlink Version 2.3E
The DSNlink Version 2.3E kit is available from the following sources:

• The DSNlink Web site:

http://www.service.digital.com/dsnlink/

Click on the link to the page for DSNlink Version 2.3E.

• An FTP directory:

ftp.service.digital.com

The Readme on the Web site explains how to copy the kit from both the Web
site and FTP directory.

• The Interactive Text Search application (ITS)

Open the DSNlink database and search for Tru64 UNIX ECO articles.

1.5 Using RIS for Client Installations
You can install DSNlink on a Remote Installation Services (RIS) server area and
then use RIS to install DSNlink on local systems. In this case, you need to do the
following:

1. Use the ris utility to install the DSNlink subsets from the distribution media
into the RIS server area.

2. Make the DSNlink subsets available on line so that subsequent installations
of DSNlink can use RIS.

3. Make sure the local system is registered as a RIS client.

4. Provide the name of the server system to the local node for the installation
procedure.

1.6 Preinstallation Requirements
This section lists the preinstallation requirements for DSNlink and how to verify
that your system meets those requirements. The following checklist is a summary
of the requirements. Before you install DSNlink, be sure to do the following:

Be able to log in to the target node as root.

Create the group for DSNlink files. See Section 1.6.3.

Check the hardware requirements. See Section 1.6.5.

Check the software requirements. See Section 1.6.6.

Determine which subsets to install. See Section 1.6.7

Determine if there is sufficient disk space. See Section 1.6.8.

Determine which transport or transports you will use to connect your
DSNlink node to Compaq. See Section 1.7.

Preparing to Install DSNlink 1–3



Preparing to Install DSNlink
1.6 Preinstallation Requirements

Set up the DECserver, if you have one, for use with DSNlink. See
Section 1.7.2.

Deinstall previous DSNlink kits. See Section 1.8.

Back up the system.

1.6.1 Time Required
A local installation takes approximately 5 to 15 minutes. An RIS client
installation may take longer because it is dependent on network activity at
the time of the installation. If the network is not active, you should expect an
installation time roughly equal to a local installation.

1.6.2 Have Root Login Privileges
You must be able to log in as root where you are installing DSNlink. Only when
you are logged in as root do you have the required permissions to install the
DSNlink software.

1.6.3 Create a Group for the DSNlink Files
Before you install DSNlink, you must create a group for the DSNlink executables.
To prevent possible security breaches, Compaq recommends that you create a
unique, new group. To make sure your system is as secure as possible, avoid
using general user group names such as users, guest, and staff. You can name
the group dsnlink.

Make sure no one is a member of the group. Its purpose is to run DSNlink. If
there are members, potential security breaches could occur because members
could read files that are otherwise readable only by the superuser.

For information on creating groups, see the addgroup (8) reference page. If
you use BIND, refer to the network setup manual. If you use Hesiod or NIS to
maintain groups, see the operating system’s documentation for instructions.

1.6.4 BIND Recommendations
Compaq recommends that you run a naming service such as BIND rather
than entering a host name manually in /etc/hosts. See the appropriate
documentation for information.

1.6.5 Hardware Requirements
Hardware Required for Installation
You must install DSNlink on an Alpha system.

Modem Hardware
If you use the modem transport for DSNlink communications, you must have
a modem dedicated to DSNlink. A dedicated modem permits the immediate
handling of both incoming and outgoing communications. Compaq uses the
incoming mode to respond to your service requests and make other connections as
you authorize.

Although DSNlink provides dialer scripts for several types of modems, you do
not have to use one of those modems. If you use a modem for which there is no
dialer script, you must create a script for the modem. For more information, see
Section 3.8.

You must also have an asynchronous serial port on your system or DECserver.
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1.6.6 Software Requirements
DSNlink Version 2.3E requires the following software:

• Tru64 UNIX Version 4.0b, 4.0d, or 5.0

• The DEC OSF/1 Base System subset (OSFBASE) must be loaded on the
system where you install DSNlink.

To verify that the subset is loaded, do the following:

1. Log in to the system where you will install DSNlink.

2. Enter the following command to verify that the OSFBASE subset is
installed. This example shows the command and the response when the
subset for Tru64 UNIX Version 5.0 is installed:

% /usr/sbin/setld -i | grep OSFBASE
OSFBASE500 installed Base System (- Required -)

If the word installed is missing or there is no response, the subset is not
loaded. For information on how to load the operating system software, see
the Tru64 UNIX documentation.

• The appropriate network software for the network transport you choose:

• X.25 for DIGITAL UNIX—the version required for your operating system
and the corresponding Compaq software

• DECnet/OSI for DIGITAL UNIX—the version required for your operating
system and the corresponding Compaq software

• TCP/IP—Tru64 UNIX includes this transport; no additional software is
required

• Modem—does not require operating system software

Modems must use MNP (Microcom Networking Protocol) class 5,
which provides error checking and data compression. See the technical
specifications for your modem to verify that it is MNP class 5 compliant
and does not disable MNP5.

1.6.7 Determining Which Subsets to Load
DSNlink has these subsets:

• DSNABASE235—with the description "DSNlink V2.3E Customer"

Load this subset on an Alpha system running Tru64 UNIX Version 4.0b, 4.0d,
or 5.0.

• DSNALANG235—with the description "DSNlink V2.3E International
Language Support"

This subset contains translated files for Japanese and French. Other
languages may be added in the future. Contact your local Compaq
representative to determine if other languages are supported.

• DSNADOC235—with the description "DSNlink V2.3E On-line
Documentation"

Load this subset to make the online documentation accessible to DSNlink.
Note that all user documentation is on line.

The DSNlink reference pages are in a separate subset.

• DSNAMAN235—with the description "DSNlink V2.3E Reference Pages"
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Load this file to have the DSNlink reference pages.

1.6.8 Determining Disk Space Requirements
The disk space requirements apply to the disks where you load the DSNlink
subsets for RIS and local installations.

Note

If you have a previous version of DSNlink on your system, you must
deinstall it before installing DSNlink Version 2.3E. If the previous subsets
remain in place, the installation fails.

Deinstalling DSNlink Version 2.3 frees 19MB of memory. For more information
about deinstalling, see Section 1.8.

Table 1–1 lists the disk space requirements for loading DSNlink software
subsets.

Table 1–1 DSNlink Kit Size

Kit Size
Size After
Installation /usr /var

7.3 MB 16.0 MB 14.0 MB 2.0 MB

To determine if your system has enough disk space, use the df command. The
following example shows the total space and free space in the /var/opt directory
on a Tru64 UNIX system:

# df -k
Filesystem 512-blocks Used Avail Capacity Mounted on
/dev/rz10d 534210 98462 382326 20% /var

1.7 Preinstallation Information for the Network Transports
You can use any of the following network transports to connect your DSNlink
node to Compaq:

• DECnet

• TCP/IP

• X.25

• Modem, which supports IDSN and PSTN line types

If you have more than one of the above network protocols, you can specify which
ones to configure for use by DSNlink. For example, if your system has all the
transports, you can configure them all or specify just the ones you want to use.
DSNlink assigns each a cost factor. When making connections, DSNlink uses the
one with the lowest cost factor.

You can add or remove transports after the installation using the DSNlink Setup
utility.
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1.7.1 TCP/IP Ports
If using the TCP/IP transport, DSNlink applications assign the ports shown in
Table 1–2.

Table 1–2 Ports Used by DSNlink Applications

Application
Abbreviation Port Application Name

dsn_nsd 2370 Name server daemon

dsn_mail 2372 DSNlink Mail

dsn_its 2373 Interactive Text Search

dsn_login 2374 Remote Login

dsn_netex 2375 Network Exerciser

dsn_sra 2376 Service Request application

dsn_k2 2377 Cryptographic Services

dsn_file 2379 File Copy

The port entries must be added to the file /etc/services. During the
installation, you can choose whether or not to have the installation procedure add
the entries to /etc/services for you.

NOTE: You can configure a single port. For more information, see the ITS article,
"V2.x How to Configure for 1 Firewall Port" in the DSNlink database.

1.7.2 Settings for DECservers
DSNlink supports the DECserver 700/MC.

To see the current settings for a terminal server port, log in to the DECserver,
enable privileges, and enter the LIST PORT n command (where n) is the terminal
server port number where the DSNlink modems are to be attached).

Recommended DECserver parameters are shown in the following example:

Local> LIST PORT n

Port n:

Character Size: 8 Input Speed: 9600 1
Flow Control: CTS 2 Output Speed: 9600
Parity: None Modem Control: Enabled

Access: Remote Local Switch: None
Backwards Switch: None Name: DSN_MODEM_nnn 3
Break: Local Session Limit: 1
Forwards Switch: None Type: Soft

Preferred Service: None

Authorized Groups: 0
(Current) Groups: 0

Enabled Characteristics: 4

Dialup, DTRwait, Input Flow Control, Output Flow Control,

1 This number must match the DTE speed of the modem.

You can enter any speed your modem can achieve.

2 CTS flow control is recommended. XON flow control may result in errors.
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3 Be sure the port name is unique.

4 Disable the Remote Modification characteristic.

Note: When Remote Modification is enabled on the terminal server port, it
accepts the modem speed from the modem device definitions file until the
speed setting is greater than 38400. Above 38400 bps, the terminal server
port ignores the speed setting in the modem device definitions file and uses
9600 baud instead. Disabling Remote Modification on the terminal server
port and setting it to a port speed greater than 38400 corrects the problem.

1.7.2.1 Make Notes for Installation Questions
Make notes about the following items, which you need for the modem transport
installation questions:

The line type, which can be either PSTN or ISDN.

The DTE speed, which is set by the modem manufacturer. If you use an LTA
device, the DTE speed also appears in the port specification.

The modem’s phone number, including any prefixes for local and long distance
calls.

For DECservers:

• A LAT number, which you can choose during the installation. You enter
this device for the prompt for the ISDN or PSTN modem device name.

• The server name. You enter the name at the prompt for the LAT terminal
server name.

• The port name. You enter the name at the prompt for the LAT terminal
server’s port name.

1.7.3 Modem Dialer Scripts
If you want to use the modem transport, you must have a dialer script for your
modem. DSNlink includes dialer scripts for several modems. If yours is not in
the list, you can modify one of the provided scripts.

For information on modem scripts, see Section 3.8.

1.8 Deinstalling DSNlink Kits
The DSNlink installation stops if any of these versions of DSNlink are installed
on your system:

• DSNlink Version 2.0

• DSNlink Version 2.1

• DSNlink Version 2.1A

• DSNlink Version 2.3

• DSNlink Version 2.3E

Therefore, you must use the following procedure to deinstall the kits before
proceeding with the next DSNlink installation. Note that the deinstallation
process does not delete customizable files. For a list of the files that are NOT
deleted, see Table 1–3.

To remove existing DSNlink subsets and the directory paths for them:

1. Log in as root to the system containing the subsets to remove.
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2. The following commands deinstall different versions of DSNlink. Enter the
one that applies to the version of DSNlink you want to deinstall:

• For DSNlink Version 2.0 for Tru64 UNIX, use this command to remove
the base and documentation subsets:

# setld -d DSNABASE200 DSNADOC200

• For DSNlink Version 2.1, use this command to remove the base,
documentation, language, and reference pages subsets:

# setld -d DSNABASE210 DSNADOC210 DSNALANG210 DSNAMAN210

• For DSNlink Version 2.1A, use this command to remove the base,
documentation, language, and reference pages subsets:

# setld -d DSNABASE211 DSNADOC211 DSNALANG211 DSNAMAN211

• For DSNlink Version 2.3, use this command to remove the base,
documentation, language, and reference pages subsets:

# setld -d DSNABASE230 DSNADOC230 DSNALANG230 DSNAMAN230

• For DSNlink Version 2.3E, use this command to remove the base,
documentation, language, and reference pages subsets:

# setld -d DSNABASE235 DSNADOC235 DSNALANG235 DSNAMAN235

The deinstallation procedure asks if you want the installation procedure
to automatically modify the file /etc/services and /etc/inetd.conf. If you
answer yes, the deinstallation procedure removes entries for DSNlink
from those files.

Note that the DSNlink Version 2.3E deinstallation process does not
correctly delete the X.25 entities. For information on how to delete them,
see the DSNlink Version 2.3E for Tru64 UNIX Release Notes.

3. If you do not want to reinstall DSNlink, also delete the files listed in the
Table 1–3.

Do not delete other directories left behind if you are reinstalling DSNlink.

The deinstallation procedure does not delete all DSNlink files and directories.
Therefore, if you do not want to reinstall DSNlink, you should delete the files and
directories shown in Table 1–3. They are all rooted at /var/opt/DSNA235.
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Table 1–3 Files Not Deleted by a Deinstallation

Directory Contents Description of the Files

config DSNlink-Biz, DSNlink-Flash,
DSNlink-Info, DSNlink-
Survey

Distribution lists for mail from Compaq

config routemap The route map for making connections
between your system and Compaq

config dsn_local_auth.dat
dsn_remote_auth.dat

The file that permits local users access to
DSNlink
The file that allows Compaq access to your
DSNlink applications

config .dsnrc The configuration file

config dsn_sra_signature.txt A signature file that is automatically
appended to service requests

keys MD5-DIGITAL-access_
number

Your authentication keys

logs dsn_history.log and
application log files

Log files that record DSNlink usage

public /incoming and /outgoing Directories for files copied to and from
your system using the DSNlink File Copy
application

Note: The /outgoing files directory is not
used. Specialists cannot use the DSNlink
File Copy application to copy files from
your system even if they are placed in that
directory.

Note that the online documentation is in the /usr/lib/dsn/help directory. If you
customized any documentation files you want to keep, you should rename or move
them before installing DSNlink Version 2.3E.

Note

The deinstallation procedure removes the modem scripts in /usr/lib
/dsn/modem. If you modified DSNlink Version 2.3 scripts and want to
keep them, rename or move them before reinstalling DSNlink. DSNlink
Version 2.0 scripts are obsolete.

1.8.1 Deleting the X.25 NCL Configuration
When deleting old DSNlink base subsets with setld, you can choose to delete the
X.25 entities or modify them afterwards.

Note that deleting the entities disconnects any currently established X.25
connections.

1.9 Backing Up Your System
Compaq recommends that you back up your system before installing any
software. For details on performing a system backup, see your Tru64 UNIX
documentation.
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1.10 Stopping the Installation
You can stop the installation procedure any time by entering Ctrl+C. However,
files created up to this point are not deleted automatically. You must delete these
files. Appendix B lists the directories created during the installation procedure.

1.11 Error Recovery
If errors occur during the installation, the system displays failure messages. If
the installation fails due to insufficient disk space, the installation procedure
displays a message indicating that there is not enough file system space for the
subset and that it will not be loaded.

Errors can occur during the installation if any of the following conditions exist:

• The operating system version is not supported.

• The prerequisite software is not installed, or its version is not supported.

• DSNlink has already been installed.

• The target architecture is not Alpha.
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Installing DSNlink on a Tru64 UNIX System

This chapter provides a sample installation for DSNlink Version 2.3E.

Before starting the installation, read Chapter 1, which describes options and
requirements for installing the product.

For information about the DSNlink documents you can print or display before
you install DSNlink, see Section 3.1.

Warning

DECnet/OSI for DIGITAL UNIX may hang the installation. We
recommend shutting down DECnet during the installation using this
command:

# /usr/sbin/decnetshutdown

You can restart DECnet with this command:

# /usr/sbin/decnetstartup

2.1 Installing the tar File
Start the installation procedure as follows:

1. Log in as superuser (login name root) where you are installing DSNlink.

2. Create a scratch directory for extracting the tar file’s contents. For example:

# mkdir /usr/scratch

3. Set default to the scratch directory:

# cd /usr/scratch

4. Extract the contents of the tar file:

# tar xvf /usr/scratch/DSNA235.tar

5. Begin the installation with a setld command that specifies the load function
(-l) and identifies the directory where the DSNlink subsets are located. For
example:

# setld -l /usr/scratch/dsna235/kit
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2.2 Sample Installation
The following installation procedure configures all transports, TCP/IP, DECnet,
X.25, and modem. Your installation will vary from this script depending on your
choices of subsets and transports and whether a previous version of DSNlink was
installed. If you deinstalled previous versions of DSNlink for Tru64 UNIX, some
files remain which this installation procedure renames and saves.

The installation script uses the following sample entries, which you change to the
names your system uses:

• The installer created the group dsn before starting the installation.

• DSNlink is installed on a node named Wynken.

• The sample access number is 1234567.

• Default values appear within square brackets ([ ]). You can accept the default
value by pressing the Return key. Or, you can override the default by entering
the value you want. Boldface text shows examples of entries that replace the
default values.

At the end of the sample installation are descriptions of each callout number.

----------------------------------------------------------------------------

# setld -l /usr/scratch/dsna235/kit 1

The subsets listed below are optional:

There may be more optional subsets than can be presented on a single
screen. If this is the case, you can choose subsets screen by screen
or all at once on the last screen. All of the choices you make will
be collected for your confirmation before any subsets are installed.

1) DSNlink V2.3E Customer
2) DSNlink V2.3E International Language Support 2
3) DSNlink V2.3E On-line Documentation
4) DSNlink V2.3E Reference Pages

Or you may choose one of the following options:

5) ALL of the above
6) CANCEL selections and redisplay menus
7) EXIT without installing any subsets

Enter your choices or press RETURN to redisplay menus.

Choices (for example, 1 2 4-6): 5 3

You are installing the following optional subsets:

DSNlink V2.3E Customer
DSNlink V2.3E International Language Support
DSNlink V2.3E On-line Documentation
DSNlink V2.3E Reference Pages

Is this correct? (y/n): y

Checking file system space required to install selected subsets:

File system space checked OK.

4 subset(s) will be installed.

Loading 1 of 4 subset(s)....

COPYRIGHT (c) 1995, 1998 BY DIGITAL EQUIPMENT CORPORATION.
ALL RIGHTS RESERVED.
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This software is furnished under a license and may be used and copied
only in accordance with the terms of such license and with the
inclusion of the above copyright notice. This software or any other
copies thereof may not be provided or otherwise made available to any
other person. No title to and ownership of the software is hereby
transferred.

The information in this software is subject to change without notice
and should not be construed as a commitment by Digital Equipment
Corporation.

The MD5 software contained in this product is derived from the RSA
Data Security, Inc. MD5 Message-Digest Algorithm.

This product includes software developed by the University of
California, Berkeley and its contributors.

Copyright (c) 1983, 1986, 1987, 1988, 1993
The Regents of the University of California. All rights reserved.

Press Return or Enter to continue: 4

You can stop the installation procedure at any time by pressing
Ctrl/C (by holding down the Ctrl key while you press the C
key). If you stop the installation procedure, however, files
which have been installed up to that time will NOT
automatically be removed. See the DSNlink Version 2.3E
Installation Guide for information on how to deinstall
DSNlink for Compaq Tru64 UNIX.

Press Return or Enter to continue:

These special terms and conditions are in addition to the terms
and conditions of any DIGITAL Service Agreement referenced
herein. In the event of conflict, these special terms and
conditions shall prevail.

1. Customer acknowledges and agrees that the DIGITAL proprietary
and confidential service tools specified in this
acknowledgment, and any subsequent versions installed or
provided by DIGITAL (collectively the "Tools"), and
associated documentation, are intended for DIGITAL’s use
in support of its warranty or maintenance service contract
obligations, and that Customer may use
the Tools and associated documentation during the term of the
applicable DIGITAL warranty and/or during the term of the
DIGITAL Service Agreement referenced herein, only in accordance
with these special terms and conditions and only for purposes
complementary to DIGITAL’s provision of such service.

2. DIGITAL transfers no title to or ownership of the Tools, or
any modifications thereto which are used or developed by
DIGITAL in connection with its performance of services, to
Customer. Except as expressly set forth in these special
terms and conditions, Customer shall not otherwise use, copy,
modify, remove or transfer the Tools. Customer shall not
provide or make the Tools, or any resultant diagnosis or
system management data, available in any form or manner to
any third party. Customer shall not decompile or reverse
assemble any software Tools, or analyze or examine for
reverse engineering any hardware or software Tools or any
firmware implementation of the Tools.
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3. Customer will allow DIGITAL necessary access to install,
replace or remove the Tools as DIGITAL deems necessary.
Customer’s right to use the Tools shall terminate upon expiration
or termination of the DIGITAL warranty period or service agreement.
Upon such expiration or termination of the DIGITAL warranty period
or Service Agreement, Customer will immediately cease using, and at
DIGITAL’s option, destroy or return to DIGITAL all hardware and
firmware Tools together with all copies of all versions of the
software Tools and Tools documentation in Customer’s possession and,
upon DIGITAL’s request, will certify in writing that Customer has
ceased using the Tools and documentation and that all Tools,
including archive copies of the software Tools and documentation,
have been destroyed or returned to DIGITAL.

Do you accept all the terms of the preceding license agreement (y/n)
[y]: y

DSNlink Version 2.3E for Compaq Tru64 UNIX (DSNABASE235) Installation
Procedure

This installation should take between 5 and 15 minutes to complete,
depending on the system configuration.

... checking version of Compaq Tru64 UNIX

... checking for previously installed versions of DSNlink

A unique group is required for DSNlink executables. To prevent
possible security holes, we recommend that you create a new
group to be used only with DSNlink for Compaq Tru64 UNIX. We
strongly discourage the use of general user groups such as
"users", "guest", or "staff". Use of a group such as "system",
"kmem", "operator", or "daemon" can create a serious security
problem.

This group must exist before the installation can continue.

Have you created a unique group for the DSNlink executables and
files? (y/n) [y]: 5

Enter the group name [DSNlink]: Return

The group "DSNlink" exists. Is this the correct group to use? (y/n)
[y]: Return

DSNlink V2.3E Customer 6
Copying from /dsna235/kit (disk)
Verifying

Loading 2 of 4 subset(s)....

DSNlink V2.3E On-line Documentation
Copying from /dsna235/kit (disk)
Verifying

Loading 3 of 4 subset(s)....

DSNlink V2.3E Reference Pages
Copying from /dsna235/kit (disk)
Verifying

Loading 4 of 4 subset(s)....

ERROR: The following subset must be installed before you can install
The DSNlink T2.3E-IFT3 International Language Support subset:

Worldwide Language Support - Operating System
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You will find this susbset on the Digital UNIX base operating
system CD in the ALPHA/WORLDWIDE directory. See the Digital
UNIX Installation Guide for directions on performing a
Worldwide Installation.

setld: Installation declined by subset control program (PRE_L). "DSNlink V2.3E

3 of 4 subset(s) installed successfully.

Configuring "DSNlink V2.3E Customer" (DSNABASE235)

... checking for files from previous DSNlink installations
checking /var/opt/DSNA230/config
checking /var/opt/DSNA230/keys

... saving copy of /usr/lib/dsn/config/.dsnrc in
/usr/lib/dsn/config/.dsnrc.

... creating /usr/lib/dsn/config/.dsnrc

... saving copy of ./usr/lib/dsn/logs/dsn_history.log in
./usr/lib/dsn/logs/

... overwriting /usr/lib/dsn/modem/dsn_modem_instantiate.dat

Setting the group ownership of these files or directories to
group "DSNlink":

o /usr/opt/DSNA235/bin.alpha/DsnEmailServer
o /usr/opt/DSNA235/bin.alpha/DsnFileServer
o /usr/opt/DSNA235/bin.alpha/DsnK2Server
o /usr/opt/DSNA235/bin.alpha/DsnMain
o /usr/opt/DSNA235/bin.alpha/DsnModemDaemon
o /usr/opt/DSNA235/bin.alpha/DsnModemMgr
o /usr/opt/DSNA235/bin.alpha/DsnNetExServer
o /usr/opt/DSNA235/bin.alpha/DsnNsdServer
o /usr/opt/DSNA235/bin.alpha/dsn_filed
o /usr/opt/DSNA235/bin.alpha/dsn_itsd
o /usr/opt/DSNA235/bin.alpha/dsn_k2d
o /usr/opt/DSNA235/bin.alpha/dsn_logind
o /usr/opt/DSNA235/bin.alpha/dsn_maild
o /usr/opt/DSNA235/bin.alpha/dsn_netexd
o /usr/opt/DSNA235/bin.alpha/dsn_nsdd
o /usr/opt/DSNA235/bin.alpha/dsn_srad
o /usr/opt/DSNA235/bin.alpha/dsnlogin
o /usr/opt/DSNA235/bin.alpha/dsnlogind
o /usr/opt/DSNA235/bin.alpha/lynx.cfg
o /var/opt/DSNA235/logs
o /var/opt/DSNA235/public/incoming
o /var/opt/DSNA235/public/outgoing
o /var/opt/DSNA235/spool
o /usr/lib/dsn/config/.dsnrc
o /usr/lib/dsn/config/dsn_local_auth.dat
o /usr/lib/dsn/config/dsn_remote_auth.dat
o /usr/lib/dsn/config/DSNlink-Biz
o /usr/lib/dsn/config/DSNlink-Flash
o /usr/lib/dsn/config/DSNlink-Info
o /usr/lib/dsn/config/DSNlink-Survey
o /var/opt/DSNA235/logs/dsn_history.log
o /var/opt/DSNA235/config/routemap
o /var/opt/DSNA235/keys

The next prompt requests your access number as specified in
your DSNlink cover letter.

The installation procedure enters your response in the
systemwide DSNlink configuration file,
/usr/lib/dsn/config/.dsnrc, for the parameter Local.Domain.
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Enter a list of one or more DSNlink access numbers for this system
[No default]: 1234567 7

The DSNlink node name uniquely defines your system for the
following access number(s):

1234567

Unique DSNlink node names are important if you have more than
one system running the DSNlink service tool. This name is
usually the TCP/IP host name.

This procedure uses the DSNlink node name from the Local.Node
parameter in /usr/lib/dsn/config/.dsnrc, if it exists, as the
default response in the next question. Otherwise, the
question’s default response is the output of the "hostname"
command.

Enter the DSNlink node name for this system [wynken.splat.com]: wynken 8

After you select your support center from the following list,
this procedure defines the Remote.Domain and Remote.Node
parameters in the systemwide DSNlink configuration file,
/usr/lib/dsn/config/.dsnrc.

The following lists the various Digital Customer Support
Centers throughout the world:

1) Athens, Greece
2) Australia & New Zealand
3) Bangkok, Thailand
4) Bratislava, Slovakia
5) Brussels, Belgium
6) Budapest, Hungary
7) Caracas, Venezuela
8) Colorado Springs, Colorado, USA
9) Copenhagen, Denmark

10) Dublin, Ireland
11) Evry, France
12) Helsinki, Finland
13) Herzelia, Israel
14) Hull, Canada
15) Luxembourg, Grand Duche de Luxembourg
16) Madrid, Spain
17) Mexico City, Mexico
18) Milan, Italy
19) Munich, Germany
20) Oslo, Norway
21) Prague, Czech Republic
22) Reading, England
23) Rio de Janeiro, Brazil
24) Seoul, South Korea
25) Singapore, Republic of Singapore
26) Sundbyberg, Sweden
27) Taikoo Shing, Hong Kong
28) Taipei, Taiwan
29) Tokyo, Japan
30) Utrecht, The Netherlands
31) Vienna, Austria
32) Zurich, Switzerland

Enter your Customer Support Center (1-27) [no default]:
8 9

The following entry will be used for the default remote domain
and node in /usr/lib/dsn/config/.dsnrc:

8) Colorado Springs, Colorado, USA digital/csccxo

2–6 Installing DSNlink on a Tru64 UNIX System



Installing DSNlink on a Tru64 UNIX System
2.2 Sample Installation

DSNlink applications can communicate with Digital directly,
using a single protocol, or, communicate through one or more
DSNlink gateways using multiple protocols. This feature allows
applications to communicate over heterogeneous networks.

The following figure shows some possible configurations:

+------+ [1] +------+ [2] +-------+
|NODE_B|----- TCP/IP, ----->|NODE_A|----- TCP/IP, ---->|Digital|
+------+ DECnet, +------+ DECnet, +-------+

or X.25 (DSNlink X.25, or
Gateway) Modem

+------+ [3] +-------+
|NODE_C|----- TCP/IP, ---->|Digital|
+------+ DECnet, +-------+
(DSNlink X.25, or
Gateway) Modem

Note that a DSNlink Gateway must also have the appropriate
DSNlink software installed.

Is wynken like NODE_A, NODE_B, or NODE_C in the above diagrams? [A]:1 0

You can configure the following network protocols. Choose one
or more abbreviations:

Abbreviation Network Protocol

D DECnet (Phase IV) or DECnet/OSI
M DSNlink Modem Protocol
T TCP/IP
X X.25

Enter the networking protocols you wish to use for communications
with Digital (link [2] in the diagram above). Separate each
abbreviation with a space or comma [T D M]: 1 1

You can configure the following network protocols. Choose one
or more abbreviations:

Abbreviation Network Protocol

D DECnet (Phase IV) or DECnet/OSI
T TCP/IP
X X.25

Enter the networking protocols you wish to use for communications
within your organization or company (link [1] in the diagram
above). Note that you may not use the DSNlink modem protocol.
Separate each abbreviation with a space or comma [T D]: 1 2

... checking TCP

... configuring TCP 1 3

The next question will prompt you for the fully qualified IP
hostname(s) of your system. A fully qualified hostname includes
the BIND domain, i.e., "hostname.domain", and looks something
like this:

gatekeeper.dec.com
dsnlink.service.digital.com

However, don’t use any of these. Use _your_ system’s fully
qualified IP hostname. Be sure the default is correct before
accepting it. See the bindsetup(8) reference page for more
information regarding BIND and fully qualified hostnames.

Enter one or more fully qualified IP hostnames for this system
[wynken.splat.com]: 1 4

Updating /usr/lib/dsn/config/.dsnrc with TCP hostname.
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To perform TCP/IP communications with DSNlink for Compaq Tru64
UNIX, the following entries must be made in your /etc/services
file:

dsn_nsd 2370/tcp # DSNlink name server daemon
dsn_copy 2371/tcp # DSNlink file copy - VDO
dsn_mail 2372/tcp # DSNlink mail
dsn_its 2373/tcp # DSNlink interactive text search (old protocol)
- VDO
dsn_login 2374/tcp # DSNlink remote login
dsn_netex 2375/tcp # DSNlink network exerciser
dsn_sra 2376/tcp # DSNlink service request application - VDO
dsn_k2 2377/tcp # DSNlink cryptographic services
dsn_db 2378/tcp # DSNlink interactive text search - VDO
dsn_file 2379/tcp # DSNlink file operations
dsn_osha 2380/tcp # DSNlink Obligation/Service History
Application - VDO
dsn_tunnel 2381/tcp # DSNlink multiprotocol tunnel

This procedure will modify the file /etc/services by inserting
the above line(s) at the bottom of your local /etc/services
file.

If this is not appropriate for your configuration, you may
choose to modify the file yourself after the installation. This
might be the case if, for example, /etc/services is
distributed.

Do you want the installation procedure to automatically modify
the file /etc/services? (y/n) [y]: 1 5

... modifying /etc/services ...

... saving copy of /etc/services in /etc/services.sav0

The following lines must also be added to /etc/inetd.conf:

dsn_nsd stream tcp nowait root /usr/sbin/dsn_nsdd dsn_nsdd
dsn_mail stream tcp nowait root /usr/sbin/dsn_maild dsn_maild
dsn_login stream tcp nowait root /usr/sbin/dsn_logind dsn_logind
dsn_netex stream tcp nowait root /usr/sbin/dsn_netexd dsn_netexd
dsn_k2 stream tcp nowait root /usr/sbin/dsn_k2d dsn_k2d
dsn_file stream tcp nowait root /usr/sbin/dsn_filed dsn_filed
dsn_tunnel stream tcp nowait root /usr/sbin/dsn_tunneld dsn_tunneld

This procedure will modify the file /etc/inetd.conf by
inserting the above line(s) at the bottom of your local
/etc/inetd.conf file.

If this is not appropriate for your configuration, you may
choose to modify the file yourself after the installation. This
might be the case if, for example, /etc/inetd.conf is
distributed.

Do you want the installation procedure to automatically modify
the file /etc/inetd.conf? (y/n) [y]: 1 6

... adding services for the DSNlink servers
into /etc/inetd.conf ...

... saving copy of /etc/inetd.conf in /etc/inetd.conf.sav0

Restarting the inetd daemon.
... checking DECnet
... configuring DECnet

Enter one or more node names for this system [LOCAL:.Wynken]: 1 7

Updating /usr/lib/dsn/config/.dsnrc with DECnet node name.

... creating /usr/lib/dsn/config/dsn_decnet_startup.ncl
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To perform DECnet communications with DSNlink for Tru64 UNIX
(formerly DEC OSF/1), the following task (number 0) objects
must be configured:

dsn_nsd dsn_copy dsn_mail dsn_login dsn_netex dsn_k2

Do you want the installation procedure to automatically configure
the DECnet objects? (y/n) [y]: n 1 8

The DECnet proxy database, /etc/dnet_proxy must also be modified.

You may manually configure the DECnet databases at any time by
using the following command:

# ncl </usr/lib/dsn/config/dsn_decnet_startup.ncl

Ignore any of the following messages:

FAILED IN DIRECTIVE: Delete
DUE TO: No such Entity Instance exists

... checking X25

... configuring X25

Enter one or more DTE addresses for this system
[llc2-class-0.166317634]: 1 9

Updating /usr/lib/dsn/config/.dsnrc with X.25 DTE address.

... saving copy of /usr/lib/dsn/config/dsn_x25_startup.ncl in
/usr/lib/dsn/config/dsn_x25_startup.ncl.sav2

... creating /usr/lib/dsn/config/dsn_x25_startup.ncl

To successfully configure DSNlink for use with X.25, the
following DTEs must be disabled and re-enabled:

166317634

Note that this will disconnect any currently established X.25
connections. You can perform this step at a later time.

Do you want the installation procedure to automatically configure
the X.25 entities? (y/n) [y]:

Executing NCL with the script file /usr/lib/dsn/config/dsn_x25_startup.ncl

... checking Modem

... configuring Modem 2 0

Is this a PSTN or ISDN line? [PSTN]: 2 1

Enter the DTE speed [9600]: 19200 2 2

You will now be asked to enter the local telephone number of
the modem you will be using for DSNlink. The dialer software
requires you to enter the telephone number in a special format
starting with the area code (US) or city code (outside the
US). You may enter only the digits (0-9) and you must enter
exactly 2 hyphens. For example, the following has the proper
number of hyphens:

555-555-5555

Enter the telephone number [no default]: 303-876-5432 2 3

Enter the local dialing prefix [T]: 2 4

Enter the long distance dialing prefix [T1]: 2 5

Enter the PSTN modem device name (enter ’*’ to see a list of
available devices) [no default]: /dev/lat/620 2 6
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Enter the LAT terminal server name [no default]: dsnlink_3 2 7

Enter the LAT terminal server’s port name [no default]: port_5 2 8

The following modem scripts were found in /usr/lib/dsn/modem:

File Description
---- -----------

1) co2264.ddsf_src Codex 2264
2) co2264hw.ddsf_src Codex 2264 Using HW Flow Control
3) df196.ddsf_src Digital DF196
4) df296.ddsf_src Digital DF296
5) hayes.ddsf_src Hayes Modem Dialer Script for

XON/XOFF Flow Control
6) hayeshw.ddsf_src Hayes Modem Dialer Script with

RTS/CTS Flow Control
7) multimodem.ddsf_src MultiTech MultiModem Dialer

Script for XON/XOFF Flow Control
8) multimodemhw.ddsf_src MultiTech MultiModem Dialer

Script for hardware Flow Control
9) null.ddsf_src Null Modem
10) usrobotics.ddsf_src U.S. Robotics Dialer Script

for XON/XOFF Flow Control
11) usroboticshw.ddsf_src U.S. Robotics Dialer Script

for hardware Flow Control

Enter the number of your selection (1-9) [no default]: 2 2 9

... updating /usr/lib/dsn/modem/dsn_modem_devices.dat

... updating /usr/lib/dsn/modem/dsn_modem_substitution.dat

Modem line successfully configured.

The modem daemon, if present, on line "line-000" will now be
stopped and restarted.

... stopping modem daemon
DSNlink V2.3E for Digital UNIX Modem Manager Utility
Copyright (c) 1989, 1998 by Digital Equipment Corporation
Digital Equipment Corporation Proprietary Service Tool
All Rights Reserved

-- No database found --
... reconfiguring LAT port
... starting modem daemon

Initializing modem on line line-000... 3 0
S>AT&F^M
R>^M^JOK^M^J
S>ATE0Q0V0 S0=1 S2=128 *DL0*FL3*SL0*SM2*XC1 &C1&D2&S1 &W0^M
R>ATE0Q0V0 S0=1 S2=128 *DL0*FL3*SL0*SM2*XC1 &C1&D2&S1 &W0^M
--- DsnModem::OK, Operation successful

Initialized 1 lines, 0 skipped, 0 initialize errors for specified lines
Modem line line-000 has started.
Started 1 lines, 0 already running, 0 start errors for specified lines

... saving copy of /usr/lib/dsn/config/routemap in
/usr/lib/dsn/config/routemap.sav0

... adding route map entries for the Digital CSC(s) 3 1

... adding route map entries for the name server daemon, dsn_nsdd

... copying learned route map entries

... done updating route map

... configuring the DSNlink Mailing List aliases

... saving copy of /var/adm/sendmail/aliases in
/var/adm/sendmail/aliases.sav0
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... 16 aliases, longest (dsnlink-survey) 87 bytes, 765 bytes total

The authentication key files are located in /usr/lib/dsn/keys.
If any are missing, they will be created after prompting for
the key. The mode of each file will also be set to allow
access only for root and DSNlink applications.

Press Return or Enter to continue:

Enter the MD5-DIGITAL-1234567 authentication key 3 2
[no default]: 0DIGITAL-1234567-ACE4-ZYI5-O6CC-74EW

... setting mode of /usr/lib/dsn/keys/MD5-DIGITAL-1234567 to u=rw,g=r,o=

The DSNlink Service Request Application requires the name and
phone number of the primary contact for your contract. This
information, which is stored in the file

/usr/lib/dsn/config/dsn_sra_signature.txt

is appended to all service requests.

... saving copy of /usr/lib/dsn/config/dsn_sra_signature.txt in
/usr/lib/dsn/config/dsn_sra_signature.txt.sav3

Enter the name of the primary contact [no default]: Ferd Berfle 3 3

Enter the phone number of the primary contact [no default]: 303-555-4643

Beginning the DSNlink for Compaq Tru64 UNIX Installation
Verification Procedure (IVP). 3 4

This procedure will run the DSNlink Network Exerciser Utility
which will send 10 random-length messages to the Digital
DSNlink Host System.

DSNlink V2.3E for Compaq Tru64 UNIX Network Exerciser Utility
Copyright (c) 1989, 1999 by Digital Equipment Corporation
Compaq Computer Corporation Proprietary Service Tool
All Rights Reserved

Connecting to target csccxo.digital.dsn. Please wait...
Connection established.
Connection path used:
Encounter #0
System ID: 1234567/wynken
System Information: OSF1 wynken.splat.com V3.2 240 alpha
Inbound Link: ---
Outbound Link: T/wynken.splat.com/3533 => T/super.cxo.dec.com/dsn_netex

Encounter #1
System ID: Digital/csccxo
System Information: VMS SUPER V6.2 0 VAX
Inbound Link: T/wynken.splat.com/3533 => T/super/DSN_NETEX
Outbound Link: ---

Stats: M10/9/9/0 B17572/101130/101130/0 C101130
Testing complete.

Messages Sent: 10
Messages Read: 10
Messages Good: 10
Messages Bad: 0
Bytes Sent: 17572
Bytes Read: 118702
Bytes Good: 118702
Bytes Bad: 0
CPS: 118702

The DSNlink for Tru64 UNIX Installation Verification
Procedure has successfully completed. DSNlink for Tru64 UNIX

has been successfully installed and configured.
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Configuration of DSNABASE235 successfully completed. 3 5

Configuring "DSNlink V2.3E On-line Documentation" (DSNADOC235)

Configuring "DSNlink V2.3E Reference Pages" (DSNAMAN235)

# exit
#

----------------------------------------------------------------------------

These are the descriptions of each callout in the sample installation:

1 The path /DSNA235/kit is typical. If it does not apply to your kit, enter the
appropriate path.

2 The International Language Support subset contains support for local
languages. The present kit contains translated files that make parts of the
user interfaces appear in Japanese or French.

Install this subset only if you want to use one of the provided languages. You
must also set the LANG environment variable to specify the language and
install the worldwide subsets before you can use this feature.

If you do not install this subset, the DSNlink interface is in English.

If you do not see all four subsets listed, it is because a previous version of
DSNlink is installed. You must deinstall the previous version of DSNlink
before you can install this kit. For information about deinstalling DSNlink,
see Section 1.8.

3 Compaq recommends that you install these subsets for the minimum
installation:

• 1) DSNlink V2.3 Customer

• 3) DSNlink V2.3 On-line Documentation

• 4) DSNlink V2.3 Reference Pages

Install subset 2) DSNlink V2.3 International Language Support only if you
have installed the prerequisite subsets and intend to use DSNlink in a
language other than English.

4 If you start and then stop the installation procedure, be sure to deinstall the
partial kit before you attempt the installation again. Deinstalling DSNlink is
explained in Section 1.8.

5 If you have not created a unique group for the DSNlink files, you can enter
n (no), create the group in another window, return to the prompt and enter y
(yes). After you enter the group name at the next prompt, DSNlink checks for
its existence before proceeding. Or, you can press Ctrl+C to exit the procedure
and create the group. If you do so, you do not have to deinstall DSNlink
before starting another DSNlink installation procedure.

If you answer n (no), DSNlink does not exit the installation or prompt you
for the group name, but cycles through the prompts for the group name.
Therefore, enter n if you want to create the group in another window and
then resume the procedure.

In this example, the previously created group has the name dsn.

6 DSNlink installs the subsets you specified in step 3 .
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7 Enter your access number as it appears in the DSNlink authorization letter
from Compaq.

Different countries use different types of access numbers. Some countries
use contract numbers, serial numbers, or some other identifier for the access
number. That number appears in the authorization letter and should be
entered for the local domain. The following are examples of access numbers
in use in the United Kingdom and Ireland:

0AY12345678-A2100 A serial number and system type
CLUK1234567-CLUST Clustered systems
03UK1234567-AESDSN United Kingdom serial number and system type
16IR1234567-AESDSN Ireland serial number and system type
SIOLO123556-SITE New contract serial number

If you have more than one access number, enter a space between the numbers.
The first number becomes your default access number.

If you have many access numbers, you do not have to enter all of them during
the installation. One access number is sufficient. However, you must enter
all access numbers you will use with DSNlink after the installation. For
information on the procedure, see Section 3.7.

8 For simplicity, accept the default name. You can enter the short, commonly-
used name for your node as your DSNlink node name. This example enters
the short name wynken. If you wish, you may enter both the long name,
such as wynken.splat.com, and the short name. Separate multiple names
with spaces or commas.

DSNlink uses the name to define the parameter Local.Node in your
systemwide configuration file, /usr/lib/dsn/config/.dsnrc. If this is
a reinstallation, DSNlink saves your current .dsnrc file, and a message
displays the saved file’s name.

If you need to change the name later, use the DSNlink Setup utility, as
explained in Section 3.7.

9 Choose the Customer Support Center (CSC) given in the authorization letter
from Compaq. You can also get the location of your support center from
your Compaq account representative. Be sure to choose the correct support
center because it has the authentication files necessary for connections. If you
choose another support center, the installation verification procedure fails.

After you choose a support center, DSNlink defines the Remote.Domain
and Remote.Node parameters in your systemwide configuration file. The
definitions allow your system to communicate with the Compaq host system.
In this example, the Remote.Domain is digital and the Remote.Node is
aestls.

1 0 Answer NODE_A if the specified node communicates directly with Compaq
without going through another intermediate node at your site and if there is
one or more DSNlink nodes connected to it.

Answer NODE_B if the specified node routes connections to some other
DSNlink node that connects to Compaq. In this case, this prompt appears:

Because this system is unable to communicate directly with
Digital, you will now be asked for the name of the DSNlink
gateway for each protocol you have specified.
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At the prompt for the node name, enter the name of the gateway node
in the format required by the transport used by the node. For example,
if the gateway is configured to use X.25 and TCP/IP, two prompts appear
for each name. Enter the name in X.25 format and the name in TCP/IP
format. For example, the X.25 name could be booster and the TCP/IP name
booster.eng.splat.com.

Answer NODE_C if the node communicates directly with Compaq and has no
other DSNlink nodes connected to it.

NOTE: If you install DSNlink on a NODE_B node before you install on a
NODE_A gateway, the installation verification procedure (IVP) fails because
there is no connection to the Compaq host. To ensure that connections will
work after you install DSNlink on the gateway, at the prompts for a gateway,
enter the name of the node where you will install DSNlink. After you install
DSNlink on the gateway node, return to this node and use the DSNlink Setup
utility to run the IVP. For more information on the DSNlink Setup utility, see
Section 3.7.

If you want to change a Node A or Node C to a Node B, or a Node B to a
Node A or Node C, use the DSNlink Setup utility, menu item c. For more
information, see Section 3.7.

1 1 If you reply to the question in step 1 0 that your system is like either NODE_A
or NODE_C, DSNlink asks for the transports to configure for use between
your system and Compaq. If you configure more than one protocol, DSNlink
chooses the one with the lowest cost factor when making a connection to
Compaq.

DSNlink checks your system for the TCP/IP, DECnet, and X.25 protocols. If
they are installed, DSNlink enters them as default choices. If they are not
installed, DSNlink does not install them for you.

Note that you can configure the modem transport only on a DSNlink node
that makes outgoing connections to the DSNlink host, as shown by links [2]
and [3] in the diagram. You cannot configure the modem transport for use
within your site.

1 2 If you reply to the question in step 1 0 that the system you are installing on
is like NODE_A or NODE_B, DSNlink asks for the transports to configure
for use between NODE_B and the NODE_A. If you install more than one
protocol, DSNlink chooses the one with the lowest cost factor when routing
DSNlink connections between systems at your site.

1 3 DSNlink begins configuring the transports you chose in steps 1 1 or 1 2 . If you
change transports later, you can reconfigure them from the DSNlink Setup
utility. (See Section 3.7 for information.)

1 4 Enter the fully qualified TCP/IP host name. If you do not enter the fully
qualified name, Compaq cannot resolve the name to connect back to your
DSNlink system. For example, if you entered wynken, Compaq would not
have enough information to locate the system. The name wynken.splat.com
is, in this example, a fully qualified TCP/IP node name.

A fully qualified host name for the node is similar to the following:
host.school.edu or host.group.company.com.

1 5 Enter y (yes) if you want DSNlink to automatically enter the lines in /etc
/services.

If you enter y (yes), DSNlink modifies /etc/services. DSNlink saves the
previous version of the file, and a message tells you the file name.
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Enter n (no) if you want to enter the lines after installing DSNlink. Note that
the file must have the additional lines before you can use DSNlink.

1 6 Enter y (yes) if you want DSNlink to modify the /etc/inetd.conf file to
contain the entries. DSNlink saves the previous version of the file, and a
message tells you the file name.

Enter n (no) if you want to enter the lines after installing DSNlink. Note that
the file must have the additional lines before you can use DSNlink.

1 7 If you chose to configure DECnet, this prompt appears. Enter the node name
as required by DECnet.

1 8 Enter y (yes) if you want DSNlink to modify the objects. If you choose yes,
DSNlink displays this message:

Executing NCL with the script file /usr/lib/dsn/config/dsn_decnet_startup.ncl

Enter n (no) if you want to configure the objects yourself after installing
DSNlink. Note that the additions must be made before you can use DECnet.

1 9 If you chose to configure X.25, this prompt appears. The default values
are your network names and addresses. DSNlink scans for the DTE (Data
Terminal Equipment) addresses and enters their names. Enter the ones you
want to use.

2 0 If you chose the modem transport, DSNlink displays a series of prompts that
allow your modem to connect to Compaq.

2 1 Enter either ISDN or PSTN, depending on which type of line you have.

2 2 Enter the DTE speed for your modem transport. You can enter the highest
speed your modem supports. Enter digits only—no commas. Note that the
Compaq host and your modem negotiate the transmission speed at connect
time, which may be lower than your modem’s maximum speed.

2 3 Enter your modem’s telephone number. Make sure the number you enter is
composed of only digits and hyphens. The following example shows how to
enter modem phone numbers:

If you write it like this: Enter this:
------------------------- ----------
(719)592-1235 719-592-1235
16-93.24.25.26 16-93242526
(31)30-28323640 31-30-28323640
0171 123556 44-171-123556

In the above example, the parts of the last phone number are:

• 0171 - area code

• 123556 - telephone number

• 44 - long distance code

• 171 - the area code without the leading 0 (zero)

Enter all the numbers, such as 44-171-123556, even if your Support Center is
a local call. The host removes any unnecessary numbers when dialing your
system.

DSNlink uses the telephone number of your Customer Support Center as a
model for the number you should enter. Use that number as a guide to how
to enter your telephone number.
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2 4 The local dialing prefix is anything you use before you dial a local number.
For example, if you dial 9 to escape your site’s local network, 9 is the local
prefix. You do not have to enter T (for tone dialing) or P (for pulse dialing) if
your modem is set up to accommodate either mode.

2 5 The long distance dialing prefix is whatever you use before you dial a long
distance number. For example, if you dial 8 to escape your site’s local
network, 8 is the long distance prefix.

2 6 The PSTN or ISDN modem device name can be found in your system’s device
directory. LAT devices are in /dev/lat/nnn. A hardwired connection is found
in /dev/ttynn.

DSNlink checks the device name you enter to make sure it is not in use. If
the line is in use, a message notifies you. You can see a list of devices by
entering an asterisk (*) at the device prompt. DSNlink displays a list of
available devices for you to choose from.

2 7 If you use a LAT device in step 2 6 , enter the LAT terminal server name. For
example: DSNLINK_3.

2 8 If you use a LAT device in step 2 6 , use the LAT terminal server port here. For
example, PORT_5.

2 9 If your modem is not listed, do not stop the installation procedure. Instead,
choose the script you intend to modify or the null script. If the modem is
the only network transport you use to connect to the DSNlink host, the
script cannot dial your modem, and the installation verification procedure
(IVP) properly fails. However, although the IVP fails, the modem scripts are
installed and are available for you to modify.

After you create a script for your modem, as explained in Section 3.8, use
the DSNlink Setup utility, menu item m, to reconfigure the modem transport
and choose your script’s name. Then use the DSNlink Setup utility, menu
item v, to run the IVP which creates a connection to Compaq if the modem
script is usable. For information on starting the DSNlink Setup utility, see
Section 3.7.

3 0 The line name is always line-000. DSNlink supports only single modem lines
on customer systems.

3 1 DSNlink creates the entries for your route map based upon your previous
responses. If you have problems connecting to Compaq, do not edit the route
map. Instead, after the installation is complete, use the DSNlink Setup
utility to correct the problems. For details, see Section 3.7.

3 2 Enter the authentication key as it appears in your authorization letter.
DSNlink is insensitive to the case of the letters in the key.

Caution

Safeguard the authentication key. Anyone who knows it can impersonate
you in communications with Compaq. The authentication key file provides
the necessary security for DSNlink to create communication connections
between your system and Compaq.
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If you mistype the key, wait until the end of the installation procedure
and then become root and edit the file /usr/lib/dsn/keys/MD5-DIGITAL-
access_number. For more information, see the section on authentication keys
in the chapter, Maintaining DSNlink, in the DSNlink User’s Guide.

For more information about the MD5 algorithm and authenticating messages
from Compaq, see the section on security in the Overview chapter of the
DSNlink User’s Guide. For directions on displaying the User’s Guide, see
Section 3.10.

3 3 This prompt and the next one request the name and phone number of the
person to call, if necessary, about service requests. Be sure to enter your area
code with the phone number.

From your responses, DSNlink creates a signature file that DSNlink
automatically appends to new service requests. Compaq specialists call that
person only if they cannot respond to the service request electronically.

When you submit a service request, you do not see the signature file although
it is included. Be sure the contact information remains accurate.

See the chapter, Processing Service Requests, in the DSNlink User’s Guide
for information on updating the service request signature file if you want
to change the contact information. For directions on displaying the User’s
Guide, see Section 3.10.

3 4 The installation verification procedure (IVP) uses the Network Exerciser
utility, which is part of the DSNlink kit, to test the connection between your
system and the Compaq host. If the IVP succeeds, you are ready to use
DSNlink. If the IVP fails, check your responses to the prompts for:

• Your access number, step 7

Note that the IVP tests each access number. If any one of the access
numbers fails authentication, an AUTHFAIL message appears and the
IVP fails.

• The DSNlink node name, step 8

• The Customer Support Center, step 9

• The addresses for the network protocols, steps 1 4 , 1 7 , or 1 9

• Modem setup information, steps 2 1 through 2 9

• Your authentication key, step 3 2

If all are correct, contact Compaq for assistance.

If you mistyped any of the above, you can use the DSNlink Setup utility to
change your responses.

For more information on the DSNlink Setup utility, see Section 3.7.

3 5 The installation and verification has completed successfully.

Please see Chapter 3 for information about the postinstallation tasks.

If you start at the C shell, install DSNlink as superuser, exit the superuser
prompt, and see unrecognized command messages when you attempt to start
DSNlink, become superuser again and enter the rehash command. Then exit the
superuser prompt and enter the DSNlink commands again.
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Postinstallation Tasks

This chapter explains what you need to do after installing DSNlink to make it
ready for use.

3.1 Printing the Release Notes and Other Documents
The following documentation files are in the Web site and FTP directories:

• DSNlink Version 2.3E for Tru64 UNIX Installation Guide - this guide

dsna235_iguide.ps.Z
dsna235_iguide.txt.Z

• DSNlink Version 2.3E for Tru64 UNIX Release Notes

dsna235_relnotes.ps.Z
dsna235_relnotes.txt.Z

• DSNlink Version 2.3 for Compaq’s DIGITAL UNIX Quick Reference Card

dsna230_quickrefcard_8x11.ps
dsna230_quickrefcard_a4.ps

• DSNlink Version 2.3E for Tru64 UNIX Service Tool Description

dsna235_servtooldes.ps
dsna235_servtooldes.txt

To uncompress the files, use the uncompress command. For example:

% uncompress dsna235_servtooldes.ps.Z

The result is the PostScript file dsna235_servtooldes.ps, which is ready to print.

Online Release Notes
You can also read the release notes on line. To do so, from the DECwindows Motif
interface, start DSNlink using the dxdsn command. From the DSNlink main
window, choose Help => Release Notes. DSNlink displays the release notes in the
Mosaic browser.

To read the release notes from the command line interface, enter this command:

% dsnhelp

From the list of topics, choose the Release Notes. DSNlink displays the release
notes in the Lynx browser.

3.2 Overview of the Postinstallation Tasks
Required Postinstallation Tasks
The only required postinstallation task is necessary if you communicate with
Compaq using a modem that lacks a dialer script. You must create or modify a
dialer script for your modem. For more information, see Section 3.8.
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Optional Customizations
The following tasks are optional:

• Modify the local and remote authorizations files to specify who can
use DSNlink applications. For details on local authorizations files, see
Section 3.3.1. For details on remote authorizations files, see Section 3.3.2.

• Customize the values supplied to DSNlink applications by modifying the
configuration file. You can also create configuration files for individual
DSNlink users. For more information, see Section 3.4.

• Specify recipients, other than root, for mail from Compaq. See Section 3.5.

• Create a signature file for mail messages. See Section 3.6.

• Create initialization files for Interactive Text Search (ITS) sessions. For more
information, see section 3.3.3, Using an Initialization File, in the DSNlink
User’s Guide. For information on accessing the User’s Guide, see Displaying
the DSNlink User’s Guide in Section 3.10.

3.3 Establishing Who Can Use DSNlink
This section explains how to control who has access to DSNlink applications both
at your site and from Compaq hosts.

3.3.1 Specifying Local DSNlink Users
Unless you change it, all users at your site are allowed access to all DSNlink
applications and the Network Exerciser utility. You can edit the local
authorizations file to specify who is allowed to use DSNlink applications at
your site. For example, you may want to limit who is allowed to submit service
requests. The local authorizations file is in:

/usr/lib/dsn/config/dsn_local_auth.dat

For information on modifying the file:

1. Start DSNlink with this command:

% dxdsn

2. From the DSNlink main window, choose Help => User’s Guide.

3. From the Table of Contents, go to chapter 8 and choose the link to section
8.2, Specifying Who Can Use DSNlink Applications at Your Site. (To choose
a link, use the arrow keys to move the cursor to the section you want, then
press the Return key.)

If you do not have the DECwindows Motif interface, from the command line
interface, enter:

% dsnhelp utilities

DSNlink displays chapter 8 from the DSNlink User’s Guide in the Lynx browser.
Choose the link to section 8.2, Specifying Who Can Use DSNlink Applications at
Your Site.
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3.3.2 Specifying Remote Access to DSNlink
The remote authorizations file controls which DSNlink applications Compaq can
initiate on your system. The file gives Compaq access to these applications:

• File Copy — allows Compaq to copy files to DSNlink directories on your
system.

• DSNlink Mail — allows Compaq to send mail to you and to respond to service
requests.

• Network Exerciser — allows Compaq to initiate network tests from the
Compaq host.

The remote authorizations file disallows remote logins through DSNlink. When
you want to permit Compaq specialists to log on remotely, edit the remote
authorizations file in:

/usr/lib/dsn/config/dsn_remote_auth.dat

For information on modifying the file, see the DSNlink User’s Guide, which you
can access by following this procedure:

1. Enter this command:

% dxdsn

2. From the DSNlink main window, choose Help => User’s Guide.

3. From the Table of Contents, go to section 8.3, Allowing Remote Access to
DSNlink.

If you do not have the DECwindows Motif interface, from the command line
interface, enter:

% dsnhelp utilities

DSNlink displays chapter 8 from the DSNlink User’s Guide in the Lynx browser.
Use the arrow keys to move the cursor to the section on Allowing Remote Access
to DSNlink. When the section is highlighted, press the Return key.

3.4 Modifying the Configuration File
The DSNlink kit includes a systemwide configuration file in:

/usr/lib/dsn/config/.dsnrc

The purpose of the configuration file is to supply values for applications.
Optionally, you can create local configuration files for individual DSNlink users.
When you start an application, DSNlink reads the local configuration file, if it
is present, and then the systemwide file for any values not supplied by the local
file. Those values appear in DSNlink fields and set toggle switches on or off. The
configurable elements in the configuration file(s) are called parameters.

The DSNlink installation modifies the configuration file so that it contains the
parameters necessary for DSNlink to connect to Compaq. You do not need to add
any other values. However, to save time when using DSNlink applications, you
may want to define optional parameters.

For information on customizing the systemwide configuration file or creating local
configuration file, see the DSNlink User’s Guide using this procedure:

1. Start DSNlink in the DECwindows interface with the dxdsn command:
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% dxdsn

The DSNlink main window appears.

2. Choose Help => User’s Guide

From the Table of Contents, go to section 8.5, Customizing Configuration
Files.

To see the information in the command line interface:

1. Enter this command:

% dsnhelp utilities

DSNlink displays a list of utilities. Choose the link to the section Customizing
Configuration Files.

3.5 Specifying Recipients for Mail from Compaq
Compaq sends you various types of communiques. The messages are sent to root,
unless you specify other recipients. To edit the mailing lists, start the DSNlink
Setup utility and choose menu item l - Edit the DSNlink mailing lists. Start the
DSNlink Setup utility with this command:

# /usr/sbin/dsnsetup

When you choose l, DSNlink displays these choices:

• Edit DSNlink-Biz

DSNlink-Biz (biz is short for business) mail explains new products and
services. This mail also provides information about updates to existing
products and services.

• Edit DSNlink-Flash

Flash mail contains urgent product information including software
engineering change orders (ECOs).

• Edit DSNlink-Info

DSNlink information mail is general product information.

• Edit DSNlink-Survey

Survey mail asks for your opinions on Compaq services and product quality.

• Exit to main menu

When you choose a mailing list, DSNlink displays the file containing the
addresses for the people to receive the mail. The editor is vi or the editor you
previously specified with the setenv EDITOR command. Put a mail address on
each line using an address format recognized by your system’s mail handler.

Forcing Communiques to a Specified Node
If your site has many systems running DSNlink, communiques from Compaq are
sent to the first system in ASCII sort order for each access number. For example,
if you have systems named corgi, kerry, newfie, and setter, and all use the same
access number, only corgi will get the communiques.

You can force the communiques to go to another system by adding a node name
to its configuration file that precedes the others in ASCII order. For example, to
have communiques delivered to node newfie:
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• On node newfie, edit the configuration file, /usr/lib/dsn/config/.dsnrc to add a
node name such as 0node (where the 0 is a zero) to the parameter Local.Node.
For example:

Local.Node: newfie,0node %DSNSETUP

• Run the Network Exerciser to create entries for the node in the host’s route
map:

% dsnnetex -N 0node

• If you use other access numbers on other nodes, repeat the procedure on the
node you want to receive the mail for that access number.

Compaq will send communiques to the nodes you specified.

3.6 Creating a Mail Signature File
Optionally, you can create a systemwide signature file for appending to mail
messages. To do so, create a text file with at least the name and phone number of
the person to contact when the response cannot be handled electronically. Put the
file in the following directory and use the following file name:

/usr/lib/dsn/config/dsn_mail_signature.txt

You can also create signature files for individual DSNlink users. For more
information, see the chapter on the DSNlink Mail application in the DSNlink
User’s Guide. (See Section 3.10 for information on displaying the User’s Guide.)

Note that there is another signature file for attaching to new service requests.
The DSNlink installation procedure prompts you for information necessary to
create that signature file but not the mail signature file. The signature file for
service requests is:

/usr/lib/dsn/config/dsn_sra_signature.txt

The contents of the files can be identical, but they cannot have the same file
name.

Note

When you create service requests or mail messages, the signature file does
not appear on the screen because it is added after you exit the Service
Request or DSNlink Mail application. However, if you copy yourself on
the submission, it appears at the end.

3.7 Changing Your Responses to Installation Questions
You can change any of your responses to installation prompts by using the
DSNlink Setup utility. The following steps explain how to change responses that
prevent the installation verification procedure from running successfully:

• Start the DSNlink Setup utility with this command:

# /usr/sbin/dsnsetup
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The DSNlink Setup utility menu appears as follows:

Compaq DSNlink V2.3E for Compaq Tru64 UNIX Setup Utility

b - Rebuild the Route Map (This is automatically done when
changing transport configurations.)

c - Change the Access Number and Remote Domain and Node and
Transport Configuration

g - Specify the DSNlink Group
l - Edit the DSNlink mailing lists
r - Restore the Cryptographic Keys
s - Save the Cryptographic Keys

d - Change the DECnet Configuration
m - Change the Modem Configuration
t - Change the TCP/IP Configuration
x - Change the X.25 Configuration

f - Verify Files Contained in Software Subsets
v - Run the Installation Verification Procedure
w - Display Current Versions of DSNlink Images

e - Exit

Enter your choice:

• To change or enter additional access numbers (also referred to as your
local domain), DSNlink node name, or Customer Support Center, enter
item c (Change the Local and Remote Domain and Node and Transport
Configuration). You can also add or remove transports using this menu item.

If you add items, such as additional access numbers or Support Centers, enter
all items, separated by spaces or commas, even if you entered the number
during the installation.

Note that if you add more than 980 characters for access numbers, you must
edit the configuration file, /usr/lib/dsn/config/.dsnrc, to add backslashes (line
continuation marks) to the local.domain parameter. For example:

Local.Domain: 1111 2222 3333 \
4444 5555

DSNlink displays prompts from the installation procedure.

• To change the node type (types are Node A, Node B, or Node C):

1. Rename the route map, /usr/lib/dsn/config/routemap.

2. Choose menu item c from the DSNlink Setup utility.

3. Change the node type and respond to related questions about transports
for use by the node.

4. Choose menu item b to rebuild the route map.

The previous route map does not exist. Therefore, DSNlink rebuilds
the route map from your template route map, /usr/lib/dsn/config
/.template..routemap.

5. Choose menu item v to run the installation verification procedure.

Verify that the messages show the expected routing.

• To change the network address for your node, choose menu item d, t, or x,
depending on which address you want to change.

• To change information about the modem transport, such as your modem’s
telephone number, use menu item m.
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• To verify that the changes allow your system to connect to the Compaq host,
choose menu item v, Run the Installation Verification Procedure.

• To exit the utility, choose e from the menu.

If your authentication key was mistyped:

1. Edit this file:

/usr/lib/dsn/keys/MD5-DIGITAL-access-number

Where access-number is the number you entered for your local domain.

2. Enter the correct authentication key.

3. If the access number was incorrect, change the file name to the correct
number.

When you have corrected the problem, attempt the IVP again by starting
the DSNlink Setup utility as described above and choosing item v, Run the
Installation Verification Procedure.

For details on using the DSNlink Setup utility, see the online documentation. To
access the documentation in the DECwindows Motif interface:

1. Start DSNlink in the DECwindows interface with the dxdsn command.

# dxdsn

The DSNlink main window appears.

2. Choose Help => User’s Guide

3. From the Table of Contents, go to section 8.7, Checking and Modifying the
DSNlink Setup.

To see the information in the command line interface, enter this command:

# dsnhelp utilities

DSNlink displays a list of utilities. Choose the link to section 8.7, Checking and
Modifying the DSNlink Setup.

Note

You may be tempted to edit files rather than use the DSNlink Setup
utility to make changes. However, many changes require modifications to
several files, which the Setup utility makes. Therefore, be sure to use the
DSNlink Setup utility to change your setup.

3.8 Creating or Modifying Modem Scripts
If you use a modem to connect to Compaq and the modem is not listed below, read
this section for information on creating a script for your modem.

DSNlink supplies scripts for the following modems:

• Codex 2264

• Digital DF196 and Digital DF296

• Hayes

• Multi-Tech modems
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• U.S. Robotics modems

If you have another modem, you must create a script for it. To create a modem
script:

1. If possible, choose an existing script to modify. The scripts are in the directory
/usr/lib/dsn/modem/ with these file names:

• co2264.ddsf_src — the Codex 2264 script for XON/XOFF flow control

• co2264hw.ddsf_src — the Codex 2264 script for CTS/RTS hardware flow
control

• df196.ddsf_src — for Digital DF196 modems

• df296.ddsf_src — for Digital DF296 modems

• hayes.ddsf_src — for Hayes™ modems, XON/XOFF flow control

• hayeshw.ddsf_src — for Hayes™ modems, CTS/RTS hardware flow
control

• multimodem.ddsf_src — for Multi-Tech® modems XON/XOFF software
flow control multimodem_eu.ddsf_src — for European Multi-Tech modems
XON/XOFF software flow control

• multimodemhw.ddsf_src — for CTS/RTS hardware flow control for Multi-
Tech modems multimodemhw_eu.ddsf_src — for European Multi-Tech
modems CTS/RTS hardware flow control

• null.ddsf_src — a script to aid in troubleshooting modem problems

• usrobotics.ddsf_src for U.S. Robotics® modems XON/XOFF software
flow control

• usrobotics.ddsf_src for U.S. Robotics CTS/RTS hardware flow control

Modem scripts may be updated in the future. For the current modem scripts,
see the following Compaq Web site:

http://www.service.digital.com/dsnlink/modem_scripts.htm

2. If you want to create a new script, use the existing scripts as a guide to the
sequence and contents of the script commands. For a list of commands, see
Appendix A.

3. See Section 3.8.1 for guidelines on modifying or creating scripts.

4. Copy your script to: /usr/lib/dsn/modem/

Be sure the file name has the format modem-name.ddsf_src, for example,
ourmodem.ddsf_src.

5. If you modify a dialer script supplied in the kit, rename it. This prevents its
being overwritten if you reinstall DSNlink later. A reinstallation replaces the
original scripts with new ones but does not delete unrecognized scripts.

For example, if you modify the co2264.ddsf_src script, your modified script
name could be co2264new.ddsf_src.

6. Test the script using the dsnmmgr test script command. The following
command tests the script ourmodem.ddsf_src (note that the file extension is
not included) at the baud rate 14400, and a dialed network address (dna) as
shown:
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# dsnmmgr test script \
-device /dev/tty02 \
-script ourmodem \
-speed 14400 \
-dna m/pstn.719-555-5555/dsn_nsd

For more information, see the dsnmmgr(8) reference page.

7. If you copied a new script to the /usr/lib/dsn/modem directory, you must
make it available to DSNlink. Start the DSNlink Setup utility as explained
in Section 3.7. Use menu item m, Change the Modem Configuration, and go
to the prompt for your modem script. Choose the script you created from the
list of modem scripts.

8. Run the installation verification procedure from the DSNlink Setup utility,
menu item v or run the Network Exerciser utility.

3.8.1 Guidelines for Scripts
The following are guidelines and suggestions for modifying and creating modem
dialer scripts:

• Modify an existing script if possible. Use a script whose control commands
are most like your modem’s commands. For example, if your modem uses
Hayes compatible commands, make a copy of the hayes.ddsf_src script and
modify it.

• For descriptions of the commands in the dialer scripts, see Appendix A.

• Make sure the modem’s description is on the same line as the Description:
label in the script. The DSNlink Setup utility and the installation process
display the description when listing the modem scripts. The following
example shows the correct placement:

!* Module Name:
!*
!* ourmodem.DDSF_SRC
!*
!* Description: Script for our modem
!*

• Make a return for each speed your modem supports.

For example, the following commands allow the modems to connect at 9600
baud. The string "12" is the modem’s result code for the 9600 connect speed.
If it is found in the RESPONSE buffer, the customer and host modems
connect at 9600 baud. The script contains these lines:

FIND "12"
IF FOUND RETURN CONNECT SPEED 9600 PROTOCOL PARAM3

• Disable the +++ escape sequence, if your modem uses it.

Most modems have an escape sequence that switches the modem from
communicating mode back to command mode. On a Hayes modem, it is the
sequence +++. Disabling the escape sequence prevents a disconnection if data
sent by DSNlink includes the escape sequence.

• Consider disabling a call waiting line, if you have one, to prevent an incoming
call from interrupting the DSNlink modem connection. You can include the
command in the dialer script.

Postinstallation Tasks 3–9



Postinstallation Tasks
3.8 Creating or Modifying Modem Scripts

For example, a *70 at the start of the dial string disables call waiting, and the
comma creates a pause for a few seconds before processing the next command:

SEND "ATDT*70,"

• Set the modem’s DTE (Data Terminating Equipment) flow control between
the modem and your computer or terminal server to CTS/RTS if you use a
DECserver. The DSNlink software protects the dc1 and dc3 characters in
data transmission so they are not interpreted as flow control.

Do not use "XON/XOFF Passthru" mode or DTR/DTS flow control.

• Use 8-bit characters. The 7-bit data transfer is not supported.

• Many modems provide a feature whereby an incoming call to the modem
causes announcement and attachment messages, such as "Ring Detected" and
"Attached: xxxx baud."

Disable these messages for incoming calls. This prevents their being
interpreted as data, which must then be discarded.

• Note that several DSNlink applications create incoming calls to your modem,
such as DSNlink Mail, the Service Request application, and Remote Login.
Therefore, you should not disable incoming calls.

• The modem should be configured so that when a dialed connection loses the
carrier (when the remote system hangs up or the line drops), the modem
lowers its DCD1 signal. This allows the operating system to signal a "carrier
lost" event to the DSNlink software.

Typically, this is achieved by:

Enabling Modem Control on the terminal server port or by using the
hupctl characteristic on the /dev/tty or /dev/lat/nnn device

If the modem understands Hayes commands, set up the &C1
characteristic in the modem’s permanent memory (AT&C1&W0).

• The modem should be configured so that if your local system terminates the
connection by lowering its DTR2 signal, the modem responds by hanging up
and resetting itself.

Typically, this is achieved by:

Enabling Modem Control on the terminal server port, using the hupctl
characteristic on the /dev/tty or /dev/lat/nnn device, or by setting the
Modem characteristic on the TXAn: or TTAn: device.

If the modem understands Hayes commands, use the &D2 command.
Compaq recommends you do this in permanent memory on the modem
(AT&D2&W0) and NOT in your dialer script because just issuing the
command can cause a modem to reset and disconnect.

• If your modem is connected to a LAT terminal server, such as a DECserver,
the terminal server port should disallow the Remote Modification feature.
This feature permits the host computer system to change the baud rate,
character length, and parity settings of the terminal server port. The
terminal server should not permit those modifications.

1 The Data Carrier Detect (DCD) signal is transmitted by the modem and read by the
computer or terminal server on pin 8.

2 The Data Terminal Ready (DTR) signal is transmitted by your computer or terminal
server and read by your modem on pin 20 of an EIA RS-232 connector.
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• If your modem has a speed buffering capability (most do), enable it. This
feature allows the modem to communicate with your computer at a fixed
speed regardless of the phone line connection speed. Use the highest DTE
speed supported by both your modem and your DTE device (computer or
terminal server port).

• For maximum throughput, use RTS/CTS hardware flow control on modem
speeds greater than 9600 baud.

3.9 Log Files
DSNlink creates several types of log files in the directory /usr/lib/dsn/logs.
You can archive or delete the files as desired.

• The history log file, dsn_history.log

This file contains records for each use of DSNlink applications. DSNlink
continues to write to this file indefinitely. Therefore, if the file gets too large,
you can create a new one and archive or delete the old log file.

• Server log files, which have the format
dsn_application_yydddhhmmss_pid.log

When Compaq connects to your system, DSNlink creates these log files.

• Records of remote login sessions, such as:

dsn_login_95006160902_23341.log and
dsn_login_95006160902_23341.log_session.

• Modem daemon run logs, which have the format
dsn_run_linetype_linename.log

These files list the modem daemon’s activities.

For more information, see section 8.4, Using the History Records and Other Log
Files, in the DSNlink User’s Guide. See also the reference page dsn_netd.sh.

3.10 Learning to Use DSNlink
Getting Started
To most efficiently learn to use DSNlink in the DECwindows Motif interface:

1. Start DSNlink with the dxdsn command:

% dxdsn

The DSNlink main window appears.

2. From the Help menu, choose Getting Started.

DSNlink displays the DSNlink Getting Started with the DECwindows
Interface.

3. Click on the modules that interest you.

Getting Help While Using DSNlink
To get help while you are using DSNlink in the DECwindows Motif interface:

• In a window, pull down the Help menu. Choose Help => Tutorial if you
want a brief set of instructions for using the application. Choose Help => On
Window if you want reference help on fields and items in the window.

• In a dialog box, click on Help.
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• To get help on an error message, choose Help => Error Messages from the
DSNlink main window. Choose the Mosaic window’s File => Find in Current...
to display a dialog box that allows you to enter a search string.

• To see the DSNlink glossary, choose Help => Glossary from the DSNlink main
window.

• To dismiss the online help windows, choose File => Exit Program from the
Mosaic window.

Getting Help on the Command Line Interface
To learn how to use DSNlink in the command line interface, enter the dsnhelp
command:

% dsnhelp

DSNlink displays a list of hypertext links. Choose the one that interests you.

Displaying the DSNlink User’s Guide

1. Start DSNlink with the dxdsn command:

% dxdsn

The DSNlink main window appears.

2. From the Help menu, choose User’s Guide.

DSNlink displays the Table of Contents and Preface for the DSNlink User’s
Guide using the Mosaic browser.

3. Click on the topic you want.
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Dialer Driver Script Facility Commands

A.1 Description
This appendix lists the commands in modem dialer scripts. The information is
intended for reference when you create a new dialer script or modify an existing
one.

The modem script language, Dialer Driver Script Facility (DDSF), must be used
to create the modem scripts for use by DSNlink applications. The purpose of a
modem script is to automate the process of dialing the phone number for the
Digital host and establishing a connection. If the connection is not established,
the script’s error handling procedures notify the user of the reason for the
connection failure.

Modem Scripts
The DSNlink modem dialer scripts are in:

/usr/lib/dsn/modem/

The scripts have the file extension .ddsf_src.

Any dialer script you create or modify must be in this directory and have the file
extension .ddsf_src to be accessible to DSNlink.

For More Information
For information on modifying dialer scripts, see Section 3.8.

A.2 Delimiters
Table A–1 describes the valid DDSF command language delimiters.

Table A–1 Supported DDSF Command Language Delimiters

Space or Tab All commands and keywords must be separated by at
least one space or tab character.

Quotation marks All text strings used in the commands must be enclosed
in quotation marks (" ").

Exclamation point An exclamation point (!) in the script file tells the DDSF
processor that any text from that point to the end of that
line is a comment and should be ignored. Do not use
comments on the command line.
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A.3 Control Characters
Table A–2 shows the format for control characters in DDSF scripts.

Table A–2 DDSF Control Characters

Control
Character

Character
Format

Control
Character

Character
Format

NUL ^@ DLE ^P

SOH ^A DC1 ^Q

STX ^B DC2 ^R

ETX ^C DC3 ^S

EOT ^D DC4 ^T

ENQ ^E NAK ^U

ACK ^F SYN ^V

BEL ^G ETB ^W

BS ^H CAN ^X

HT ^I EM ^Y

LF ^J SUB ^Z

VT ^K ESC ^[

FF ^L FS ^\

CR ^M GS ^]

SO ^N RS ^^

SI ^O US ^_

NOTE: There is no implied CR at the end of commands. Therefore, if a command requires
processing by the modem software, send a CR (carriage return) character after the command.
In general, you do not need a CR after commands that pass control or assign values within the
dialer script. For example, the ^M in the next set of commands is necessary to dial the phone
number:

SEND "ATDT"
SEND PHONENUMBER
SEND "^M"

The following commands do not require a CR:

WAITFOR 60 RESPONSE SIZE=40 TERM=8192
IF TIMEOUT RETURN TIME_OUT

A.3.1 Sending the Circumflex Character
If you need to send a circumflex (^) by itself followed by an uppercase letter, make
it two strings. For example, to send an ^ and an M:

SEND "^"
SEND "M"

A.4 Numeric Values
All numeric values specified within the script file must be in decimal (base 10)
notation. The command parser does not recognize hexadecimal, octal, or binary
numbers.
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A.5 DDSF Script Commands
The next sections describe these DDSF script commands:

• FIND

• GOTO

• IF

• INCREMENT

• LET

• ON...GOTO

• PURGE

• RETURN

• SECTION

• SEND

• SET

• WAITFOR

• WAITSTRING

• ZERO

The commands are case insensitive.
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FIND

Description

The FIND command searches the RESPONSE buffer for the specified string and
sets the FOUND and NOTFOUND flags accordingly. The maximum length of the
text string is 80 characters. If the data in the RESPONSE buffer contains the
text string, a match occurs. Null strings always set the FOUND flag.

Syntax

FIND parameter

Parameters

"string-constant"
The match string pattern used or string keyword to search for in the RESPONSE
buffer. Enclose the string in quotation marks ("string-constant").

PARAMn
Equates to the internal parameters param1, param2, or param3.

Examples

1. FIND "Ready"

This command searches the RESPONSE buffer for the string "Ready".

2. FIND PARAM1

This command searches the RESPONSE buffer for the PARAM1 string.
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GOTO

Description

The GOTO command moves the processor to the command section specified by
the value of n. If you do not declare a section for n, an error is returned. The
maximum number of section labels is 20.

Syntax

GOTO n

Parameter

n
The script section entry point for the branch.

Example

GOTO 2

This command branches to location SECTION 2 in the script file.
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IF

Description

The IF command tests one of several conditions and performs a logical execution
flow control.

Syntax

IF condition action

Conditions

RESPONSE="text"
A 512-character buffer where modem responses are stored. Use the RESPONSE
parameter to test whether the RESPONSE buffer contents are equal to the
specified text string.

[NO]TIMEOUT
A DDSF Boolean expression whose value is determined whenever a WAITFOR
command is processed. If the specified time period expires before completion of
the WAITFOR command, this Boolean expression becomes TRUE; otherwise, it is
FALSE. Use this parameter to test whether the last WAITFOR command resulted
in a timeout.

[NOT]FOUND
A DDSF Boolean expression whose value is determined whenever a FIND
command is processed. If the text string specified in the FIND command is
located within the response buffer, the FOUND Boolean expression becomes
TRUE; otherwise, it is FALSE. Use this parameter to test whether the last FIND
command was a success or failure.

COUNTERn ( <, >, =, <>, <=, >=) numeric_value
One of several DDSF counters. These counters can be used to create looping
algorithms within the structure of a script file. There are five counters:
COUNTER1 through COUNTER5. Use this parameter to compare the counter
contents with the specified numeric value, according to the specified relational
operator.

PARAMn="text"
Equates to the internal parameter param1, param2, or param3.
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Actions

GOTO n
If the condition is TRUE, branch to the specified script section (n).

LET PARAMn="string"
If the condition is TRUE, assign the string to parameter n.

RETURN exit-keyword [SPEED integer] [PROTOCOL "string"]
If the condition is TRUE, return to the caller with the specified exit-keyword and
optional SPEED and PROTOCOL values. See the RETURN command description
for more details.

Examples

1. IF RESPONSE="r^M" GOTO 3

This command compares the RESPONSE buffer to the "r^M" string. If the
string matches, go to SECTION 3.

2. IF COUNTER1>=3 RETURN DIAL_ERR

This command compares the value of COUNTER1 with 3. If they are equal,
then return DIAL_ERR status to the application.

3. IF FOUND RETURN CONNECT SPEED 9600 PROTOCOL "None"

This command checks the FOUND flag value. If the value is TRUE, then
return the CONNECT status to the application with speed 9600 and protocol
"None".
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INCREMENT

Description

The INCREMENT command adds 1 to the current value of an internal counter
COUNTERn. This command, with IF and GOTO commands, is usually used for
loop control.

Syntax

INCREMENT COUNTERn

Parameter

COUNTERn
Specifies one of the DDSF counters to be incremented. Use these counters to
create looping algorithms within the structure of a script file. There are a total of
five counters: COUNTER1 through COUNTER5.

The counters can be initialized with the LET or ZERO commands.

Example

INCREMENT COUNTER1

This command increments the keyword COUNTER1.

A–8 Dialer Driver Script Facility Commands



LET

LET

Description

The LET command allows you to set any counter to a known (or base) value.
It assists in the creation of states within the script when used with the ON
COUNTER GOTO command. Counter values cannot exceed 65535.

Syntax

LET COUNTERn = y

Parameters

COUNTERn
Specifies one of several DDSF counters to be set. You can use these counters to
create looping algorithms within the structure of a script file. There are a total of
five counters: COUNTER1 through COUNTER5.

y
The decimal value for the counter.

Example

LET COUNTER1=5

This command sets COUNTER1 to the value 5.

Dialer Driver Script Facility Commands A–9



ON...GOTO

ON...GOTO

Description

The ON...GOTO command is used to perform computed branches within the
execution of a script. Script execution branches to the section (x) whose position
in the destination list corresponds to the value in the specified counter. An error
occurs if the contents of the specified counter exceed the number of sections in the
destination list. If the counter contains 0, execution continues with the command
that follows the ON...GOTO command.

Syntax

ON COUNTERn GOTO x1 x2 x3...x10

Parameters

COUNTERn
Specifies one of several DDSF counters to be tested. You can use these counters
to create looping algorithms within the structure of a script file. There are a total
of five counters: COUNTER1 through COUNTER5.

x1 x2 x3...x10
A destination list of valid sections that exist within the script. You can specify
a maximum of 10 sections. Sections can appear more than once and in any
order within the destination list. Entries in the destination list are separated by
spaces.

Example

ON COUNTER1 GOTO 5 6 7

In this command, if the value in COUNTER1 is 1, execution branches to
SECTION 5. If COUNTER1 contains a 2, execution branches to SECTION 6,
and so on.
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PURGE

PURGE

Description

The PURGE command clears the terminal-to-modem communications channel
of any unread modem responses. Purging does not affect data already in the
RESPONSE buffer.

Syntax

PURGE

Example

PURGE

This command clears the DDSF type-ahead buffer.
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RETURN

Description

The RETURN command causes the DDSF processor to do the following
procedures, usually in this order:

• Stop processing the DDSF script file

• Assign the optional speed and/or protocol values in the DDSF status block

• Return control to DSNlink with a status code

Syntax

RETURN exit_keyword [SPEED integer] [PROTOCOL "string"]

Parameters

exit_keyword
The exit keywords equate to predefined result values. You can assign these
values to the DDSF return status block through the RETURN command. The
valid exit keywords are listed in Table A–3.

Table A–3 Valid Exit Keywords

Keywords Description DDSF Return Status

BUSY DDSF detected target line busy DDSF_S_BUSY
CALL_FAIL DDSF failed to establish the

connection
DDSF_S_CALLFAIL

CONNECT Connection established DDSF_S_CONNECT
DIAL_ERR DDSF sensed device problem when

trying to dial
DDSF_S_DIALERR

NO_ANSWER DDSF detected no answer DDSF_S_NOANSWER
NO_DIALTONE DDSF detected no dial tone DDSF_S_

NODIALTONE
TIME_OUT DDSF timed out without getting

modem status
DDSF_S_TIMEOUT

[SPEED integer]
If a SPEED value is specified, it will be put into the speed field of DDSF status
block and returned to the calling application.

The speed can be any positive integer. Common SPEED values include 300, 1200,
2400, 4800, 9600, and 19200 baud.

[PROTOCOL "string"]
If a PROTOCOL value is specified, it will be put into the protocol field of DDSF
status block and returned to the calling application. DDSF does not check the
"string" value, so you can put any value into the "string." The maximum length is
20.
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Examples

1. RETURN DIAL_ERR

This command returns to the application with exit status DDSF_S_DIALERR.

2. RETURN CONNECT SPEED 2400

This command returns to the application with exit status DDSD_S_
CONNECT, and puts 2400 into the speed field of the DDSF status block.

3. RETURN CONNECT PROTOCOL "MNP"

This command returns to the caller with exit status DDSF_S_CONNECT, and
puts "MNP" into the protocol field of the DDSF status block.

4. RETURN CONNECT SPEED 9600 PROTOCOL "Reliable"

This command returns to the caller with exit status DDSF_S_CONNECT,
and puts 9600 into the speed field, and "Reliable" into the protocol field of the
DDSF status block.

Dialer Driver Script Facility Commands A–13



SECTION

SECTION

Description

The SECTION command creates the script command sections by defining entry
points within the script file. All SECTION keywords must be followed by a
unique number in the range of 1 to 20.

Syntax

SECTION n

Parameter

n
A unique integer in the range of 1 to 20.

Example

SECTION 1

This command marks the code that follows it as belonging to SECTION 1, similar
to the way a label is used in standard programming languages. Hence, a GOTO
1 command causes script execution to resume at the first line that follows the
SECTION 1 entry point.
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SEND

SEND

Description

The SEND command lets you send a string parameter to the modem. If you
specify a script string keyword, the DDSF script processor sends the contents of
the string keyword to the modem.

Syntax

SEND parameter

Parameters

"string-constant"
A text string enclosed in double quotation marks ("").

PARAMn
Equates to the internal parameters param1, param2, or param3.

PHONENUMBER
The telephone number of the DSNlink host after any conversions by the telephone
number substitution database.

For more information on the telephone number substitution database, see the
chapter on Maintaining DSNlink in the DSNlink Version 2.1 User’s Guide. (This
is an online document accessible from the Help menu on the DSNlink main
window or by using the dsnhelp command.)
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SEND

Examples

1. SEND "^B"

This command sends a Ctrl+B character to the modem.

2. SEND "12345678"

This command sends a text string "12345678" to the modem.

3. SEND PARAM1

This command sends the string in the PARAM1 keyword to the modem.

4. SEND PHONENUMBER

This command sends the string in the PHONENUMBER keyword to the
modem.
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SET

SET

Description

Used mainly as a script debugging tool, this option enables and disables the
display of text strings received from or sent to the modem.

Syntax

SET parameter

Parameters

DISPLAY ON/OFF/FULL

The SET DISPLAY ON and SET DISPLAY FULL commands display data sent
to modem through SEND commands, and data received from modem through
WAITFOR commands. The SET DISPLAY OFF command disables this feature.

Examples

1. SET DISPLAY FULL

This command enables the DDSF debugging option.

2. SET DISPLAY OFF

This command disables the DDSF debugging option.
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WAITFOR

WAITFOR

Description

The WAITFOR command provides a mechanism for specifying a time period
during which the processor waits for a given event to occur. The event can be a
certain number of characters are received, or a terminate character is detected.

When an event is detected within the timeout period, the time_out variable is
assigned the value FALSE. Otherwise, time_out is assigned the value TRUE.

You can also use WAITFOR as a simple delay mechanism if you specify a time_
out parameter without an associated event.

Syntax

WAITFOR time_out [RESPONSE] [SIZE=integer] [TERM=integer]

Parameter

time_out
This parameter specifies the maximum time in seconds the WAITFOR command
is executed.

RESPONSE
This is an optional keyword for syntax clarity.

SIZE=integer
This parameter specifies the maximum number of characters to accept by the
WAITFOR command. When it is reached, the command exits.

Be sure the size is equal to or larger than the number of characters that are
likely to be in the RESPONSE buffer.

TERM=integer
This parameter specifies a 32-bit, unsigned integer mask to be the terminator
of the WAITFOR command. Each bit corresponds to one ASCII character: bit 0
corresponds to ASCII 0, and so on. Specify the mask in decimal. A value of zero
means no terminators.

If you want the terminators to be a control character, such as ^M (CR), assign its
value to TERM parameter. For example, ^M is equal to 213 or 8192. The ^J (LF)
control character has a value equal to 210 or 1024.
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WAITFOR

Examples

1. WAITFOR 4 RESPONSE SIZE=20 TERM=8192

This command waits a maximum of 4 seconds for either 20 characters or a
CR (213) terminator received from the modem.

2. WAITFOR 10 RESPONSE TERM=1024

This command waits a maximum of 10 seconds for a LF (210) terminator
received from the modem.

3. WAITFOR 40

This command waits 40 seconds then continues with next command.

4. WAITFOR 30 RESPONSE TERM=9344

This command waits 30 seconds for the BEL, LF, and CR terminators. The
value of TERM is the combined values of BEL (128), LF (1024) and CR (8192).
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WAITSTRING

Description

The WAITSTRING command replaces the <wait> tag in the PHONENUMBER
buffer with the "string" provided and leaves the result in the PHONENUMBER
buffer.

Syntax

WAITSTRING "string"

Parameter

"string"
The "string" is composed of any valid wait characters that the modem can
interpret.

Examples

1. WAITSTRING ",,,"

The <wait> tag in PHONENUMBER buffer is replaced by ",,," in this
command. This command can be used in the DDSF script for Hayes modems.

2. WAITSTRING "="

The <wait> tag in PHONENUMBER buffer is replaced by "=" in this
command. This command can be used in the DDSF scripts for DF196
and DF296 modems.

See your modem’s specifications for what to use for the value of "string."
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ZERO

ZERO

Description

The ZERO command resets a specified counter (COUNTER1 to COUNTER5) to
zero.

Syntax

ZERO COUNTERn

Parameter

COUNTERn
The internal counter that will be initialized to zero.

Example

ZERO COUNTER1

This example initializes the keyword COUNTER1 to a value of zero.
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B
DSNlink Directories on Your System

This appendix lists:

• Directories used by DSNlink

• Directories created by DSNlink

• Files modified by the DSNlink installation procedure

Table B–1 lists the directories used by DSNlink.

Table B–1 Directories Used by DSNlink

Directory Name Description

/usr/bin/ Links for command names

/usr/sbin/ Links for system administrator

/usr/lib/x11/app-defaults Links to the resource files for the applications running
in the DECwindows Motif interface

/usr/lib/x11/uid Links to the UID files

/usr/share/man/man1 Links for reference pages

/usr/share/man/man4 Links for reference pages

/usr/share/man/man8 Links for reference pages

Table B–2 lists the DSNlink directories, which are created during the installation
procedure.

Table B–2 DSNlink Directories Created by the DSNlink Installation

Directory Name Description

/usr/opt/DSNA235/app-defaults Resource files for the applications running in the
DECwindows Motif interface

/usr/opt/DSNA235/bin.alpha Commands

/usr/opt/DSNA235/cli Files for the command line interpreter

/usr/opt/DSNA235/doc ElectronicServiceToolsLicenseAgreement.txt

/usr/opt/DSNA235/help The online documentation help files

/usr/opt/DSNA235/man The reference pages

/usr/opt/DSNA235/msg Message files

/usr/opt/DSNA235/uid.alpha UID files for DSNlink applications running in the
DECwindows Motif interface

(continued on next page)
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Table B–2 (Cont.) DSNlink Directories Created by the DSNlink Installation

Directory Name Description

/var/opt/DSNA235/config
alias: /usr/lib/dsn/config/

Configuration files:

• .dsnrc — the systemwide configuration file, also
referred to as the resource file

• DSNlink-Biz, DSNlink-Flash, DSNlink-Info, and
DSNlink-Survey — mailing lists for mail from
Compaq

• dsn_*_startup.ncl — startup files for the network
transports

• dsn_local_auth.dat — authorizations file for
DSNlink users at your site

• dsn_remote_auth.dat — authorizations file to
allow Compaq specialists access to your DSNlink
systems

• dsn_sra_signature.txt — the signature file that is
appended to service requests

• routemap — the DSNlink route map, which
has paths for connections between your site
and Compaq. (Do not edit this file. Make any
additions or changes through the DSNlink Setup
utility.)

• Template files:

• .template...dsnrc

• .template..DSNlink-Biz

• .template..DSNlink-Flash

• .template..DSNlink-Info

• .template..DSNlink-Survey

• .template..dsn_local_auth.dat

• .template..dsn_remote_auth.dat

• .template..routemap — the route map
template has entries for all Customer Support
Centers. (Do not edit this file. DSNlink uses
it for route map generation and rebuilding.)

/var/opt/DSNA235/i18n Translations of parts of the user interface.

/var/opt/DSNA235/keys
alias: /usr/lib/dsn/keys/

Cryptographic keys. (Keep the contents of the files
confidential.)

(continued on next page)
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Table B–2 (Cont.) DSNlink Directories Created by the DSNlink Installation

Directory Name Description

/var/opt/DSNA235/logs
alias: /usr/lib/dsn/logs/

Application log files:

• dsn_history.log — records of each use of DSNlink
applications

• *.log — log files created by incoming DSNlink
applications and the modem transport

/var/opt/DSNA235/modem
alias: /usr/lib/dsn/modem/

Files related to modems:

• *.ddsf_src files — modem dialer scripts

• dsn_modem_devices.dat — modem settings
established during the installation procedure

• dsn_modem_instantiate.dat — links to the
commands that start Compaq-to-customer
application servers

• dsn_modem_lines.dat — shared variables for the
modem line. Do not edit this file.

• dsn_modem_servers.dat — shared variables for
modem server processes. Do no edit this file.

• dsn_modem_substitution.dat — dialing
information and conventions

• Template files:

• .template..dsn_modem_devices.dat

• .template..dsn_modem_instantiate.dat

• .template..dsn_modem_substitution.dat

/var/opt/DSNA235/public
alias: /usr/lib/dsn/public/

Contains files copied to or from your system by
Compaq. It has two directories:

• incoming — files copied from Compaq to your
system

• outgoing — files copied from your system to
Compaq

/var/opt/DSNA235/spool Not currently used

/var/opt/DSNA235/stumps Not currently used

Table B–3 lists the files that are modified by the installation procedure.

Table B–3 Files Modified by the DSNlink Installation

File Description of Modification

/var/adm/sendmail/aliases Added DSNlink mailing lists

/etc/services Added ports used by DSNlink applications

/etc/inetd.conf Added servers for DSNlink
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